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Class 1



Importing to Lightroom

Insert your memory card now
• Does the import window 

show up?



Importing to Lightroom

• Import Photos and Video

• We’re only using 1 catalog



Importing to Lightroom
• Left Panel

• Find where 
your images 
are

• Highlight 
that location

• Center Panel
• Choose the 

process
• New images 

use COPY
• Existing 

Images may 
be ADD or 
MOVE

• Right Panel
• Destination



Importing to Lightroom
• Minimal

• Fastest on import
• Slowest during editing

• Embedded and Sidecar
• Take a little longer on import

• Standard
• Takes a little longer on import
• Not quite as slow as Minimal or Embedded

• 1:1
• Takes the longest on Import
• Largest in size
• Fastest during editing
• Can be applied after import

• Library > Previews > Render 1:1 Previews



Importing to Lightroom
Build Smart Previews

• Can be done on import or later
• Takes longer on Import
• Ability to edit within Lightroom (only) without being 

connected to an external hard drive (if that is where the 
file is stored)

Don’t Import Suspected Duplicates
• If there are images on a memory card that are new 

and some that were already imported then only new 
ones will import

Make second copy
• Ability to copy to 2 drives (one can serve as a backup)
• You can specify the location by clicking on the words 

then navigating through the file system to find 
location

Add to Collection
• If you want the entire set of images in a collection 

check this box



Importing to Lightroom

• To Rename
• Make sure box is checked

• Template
• Click on box or arrows to select template

• Shoot Name
• Type in the name you choose

• Start number
• What number do you want to start

• Sample look
• Does it look the way you want it to look



Importing to Lightroom
File Renaming
• Not available in “Add” Process
• If you don’t want to rename then 

don’t check the box
• Check “Rename Files” to 

customize the name
• Choose naming template…I use 

Shoot name-Sequence
• Choose Shoot name
• Choose Start Number

• If you add in batches you 
can continue the numbering 
by making the start number 
the next one in the 
sequence



Importing to Lightroom—Destination Panel

• I organize by subject
• Here is the way I want my folders to be
• Carter

• First Days
• Newborn
• 3 months

Organizing your files/folders/images
• Best to decide now
• By Subject
• By Date
• Combination of Date and Subject



Importing to Lightroom
Destination Panel
• Where do you want to 

store your image
• Find the main location 

and then the 
folder/sub folder

• If you need to create 
a folder or sub folder 
then RIGHT click any 
folder inside the hard 
drive file system

• Select “create new 
folder”

• Window will open



Importing to Lightroom



Importing to Lightroom



Importing to Lightroom—Destination Panel



Importing to Lightroom—Destination Panel
Center Panel
• Select images to be 

imported by 
highlighting them

• Then click on the 
check box



Import your images now

qMake sure you have the correct source located
qCheck the box for each image that is to be imported
qFill in the File Handling Panel
qFill in the Renaming Panel
qSelect destination location
qClick “IMPORT”
qWait till it’s done



Importing to Lightroom--Add

For image files that are 
already stored on a 
drive.



Importing to Lightroom--Add

Top Bar
• Source

• Where are the images?
• Computer Hard drive
• External hard drive

• Procedure
• How are you importing?

• Add
• Catalog

• File Handling
• Apply During Import



Importing to Lightroom—Add Catalog
• File Handling

• Build previews
• Minimal
• Embedded & Sidecar
• Standard
• 1:1

• Build Smart Previews
• Don’t Import Suspected Dupl.
• Make 2nd Copy
• Add to Collection

• Apply During Import
• Develop Settings
• Metadata
• Keywords

You don’t have to select a 
destination because the 
image files are already 
place

If you want to change their 
storage location then you 
would use the MOVE 
option



The Interface—Library Mode

Loop View-Single Image 
showing

Key board shortcut to 
open/close panels
• Click on Tab button



Library Module--Views
Grid View—
the thumbnail size can be adjusted 
in the bottom right corner

Keyboard shortcut—
G  Grid view
E   Loupe view (single image)



Library Module--Views

Keyboard shortcut—
g  Grid view
e   Loupe view (single image)

To move between views–
• use key board shortcuts
• icons in the bottom left 

corner



Let’s find your new images

• Go to Library Mode
• Left Panel
• Folders
• Locate the file you just used during import
• Click on that file
• Go to grid view—press the letter G or the grid icon in lower left 

corner



Interface-Left Panel



Develop Module
Getting from Library 
to Develop…

• Go to top bar and 
click on Develop

• Keyboard shortcut 
click on the letter 
D



Develop Module—My Working View
This is my working layout
• Left panel closed 

unless needed
• Right panel always 

open
• No filmstrip unless 

needed



Using the Develop Module



Using Develop Module
In the Library Module
• Highlight the image 

to work on
• Click on the letter D 

(that will take you 
into the develop 
module 

• Or go to the top bar 
and click on the 
word Develop



Using Develop Module



Using Develop Module
When clicked…clipped 
highlights will show up on 
the image in red

Camera 
settings 
are 
displayed 
here 
while 
cursor is 
over 
panel…..
not over 
image



Using Develop Module

We’ll come back to this panel



Using Develop Module
Access the needs of the image

What needs to happen to 
achieve the look you envision



Develop Module

My Work Flow
• Do I want to be able to see the 

original RAW/jpg?
• Make virtual copy

To make Virtual Copy
• Right click on the image
• From the pop up menu select 

“Create Virtual Copy”

Original Virtual Copy



Develop Module—Basic Panel

This is global editing
• These edits affect the entire image

These “preset” profile options are 
only available for RAW images…not 
Jpeg



Develop Module

• For more Profile options click on the 
4 boxes shown in the red circle above

• This window will open
• Use the arrows to the left of each to 

expand and see the options inside 
each category

• I tend to check these after I do some 
editing



Develop Module

White Balance
• Can adjust with presets
• Or eyedropper
• Or with sliders Eyedropper White Balance

• Needs to be on something you 
know is white, black, or gray

With either the presets or eyedropper tool…sliders can be 
adjusted to improve the color



Develop Module

Try the Auto Button as a start
• Keep it or Tweak it or Undo it
• To undo it…Double click on Tone or 

Commd (Contl) +Z



Develop Module—General Info
All Panels…EXCEPT the Basic Panel 
• Have a switch on the left to turn the 

effect on/off
• This will show a before and after of 

each

To show a complete Before/After
• Click on the backslash key



Develop Module—Detail Panel

These are the default settings

FYI…There are times when you may want to remove 
these amounts so just be aware that they have 
applied these automatically

Switch to turn off/on this 
affect

Make sure it’s in the up 
position to see the effect

This allows you to select the area 
of the image that you want to view
• Click on the little square
• Move cursor to the area that 

you want in the window
• Click

This allows you to close 
up the area with the 
image close up



Develop Module—Detail Panel

These are the default settings

FYI…There are times when you may want to remove 
these amounts so just be aware that they have 
applied these automatically

If you are only applying sharpening in Lightroom then
• You can apply around 100
• Or Sharpening + Luminance Noise Reduction = 

100



Develop Module—Detail Panel

To use Masking
• Hold the Alt key while sliding the masking button
• This will show the entire image as white
• As you hold the alt key and slide the slider to the 

right it will start turning black
• Slide until only the areas you want sharpened are 

white.  Unsharpened areas will be black

Black conceals, white reveals!



Class 2



Lightroom Demo



Develop Module—Lens Corrections
Profile
• Remove Chromatic Aberation

• Important for outdoor/high contrast images
• Enable Profile Corrections

• Your choice…do you like what it accomplished or not
• Lens Profile

• Many times it will auto populate
• If it doesn’t, click arrows and locate maker
• Then the lens used

• Amount…Distortion and Vignetting
• Sometimes the correction isn’t enough so you can 

move the sliders to make further adjustments



Develop Module—Lens Corrections
Before After



Develop Module—Transform

Test each option…
• Auto
• Level
• Vertical
• Full



Develop Module—Transform
Guided—
…Click on the word Guided or the icon in 
the Transform panel
…Find a line that should be perfectly 
horizontal or vertical
…Move cursor to one end of the item that 
should be horizontal or vertical> click and 
drag cursor to the other end release
…Find another that should be perfectly 
parallel with the first line. 
…Drag and drop a second line
…It should straighten both line to be 
parallel to each other
…You must drop 2 lines but can be up to 4
…Can be 2 Horizontal and 2 vertical



Develop Module—Left Panel



Develop Module—Left Panel



Develop Module--Zooming

To Zoom…
• Move cursor over main image
• You will see the cursor looks 

like a magnifying glass with + 
in the middle

• Click on part of image you 
want to view larger

• Image will zoom
• Click again to zoom out
• If zoom need to be smaller or 

larger…select one of the 
optionsYou can click inside the zoom box 

in the navigator to move the 
location shown in the center panel



Develop--Presets
Lightroom Classic comes 
loaded with presets

They are a way to automate 
the editing process

Once applied you can adjust 
the sliders to create your 
vision

Presets can be…
• Made by you
• Free giveaways
• Purchased



Develop--Presets
To Create your Own Preset…
• Edit an image to you requirements
• Click on the + next to the Presets header

For this example:
• I wanted to save just 

the Basic Lens 
Correction

• I made sure these 
were checked in the 
panel during my edit



Develop--Presets

To Create your Own Preset…
• Click on the +
• Window opens
• Create Preset
• Fill in Preset name
• Click on “group” box
• Select New Group
• Fill in the Group Name
• Create



Develop--Presets
• Select only the items that you 

want in your preset
• Create



Develop Module—Spot Removal Tool



Develop—Adjustment Brush

To use the Adjustment 
Brush
• Click on the  brush 

icon locate below 
the Histogram

• Panel will open



Develop—Adjustment Brush, Radial, Grad Filter
Adjustment Brush, Radial Filter, Grad Filter
• One or more sliders can be used on each 

adj. brush
• If sliders are adjusted before using the 

brush…those settings will be 
remembered and applied to the next 
new brush until the settings are reset by 
holding Alt (Opt) + Doubling clicking the 
word Effect at the top left of the panel

• If the sliders are all at zero and set after 
clicking the brush to the image those 
settings will NOT be applied to the next 
new brushes

• Auto Mask can be checked on or off



Develop—Adjustment Brush
• Select the Size, Feather, Flow, and 

Density
• Turn Auto mask on or off
• Click onto the image where you 

want to paint in the effect
• Then adjust the sliders
• Continue painting
• Did you paint where you didn’t 

want to paint?
• Click erase, select brush size, 

Feather, and flow
• Paint away unwanted areas



Develop—Gradient Filter



Develop—Grad Filter

Drag in the direction as 
needed

Center line 
below affected 
area

Feather area



Develop—Grad Filter

Check “Show Selected Mask 
Overlay” to see affected area



Develop—Grad Filter

To remove effect from 
areas.
• Click on Brush>Erase
• Choose to use Auto 

Mask or not
• Brush away effect 

where unwanted

Click on word BRUSH 
not the icon above



Develop—Grad Filter
Remove too much?
• Effect can be painted back in
• Hold ALT to get the add brush
• While holding ALT…Select brush size, feather, or Auto 

mask
• Paint back in area



Develop—Radial Filter
• Select Radial Filter Icon
• Drag out shape
• Adjust sliders as desired
• Adjust Feather as desired

To see affected area
• Hover over center pin
• Or check “Show selected 

mask overlay”



Develop—Radial Filter

To make adjustments 
inside the radial filter
• Click on radial filter 

icon
• Check invert box
• Move desired sliders
• Click “Done” when 

finished with radial 
filter adjustments

To add another radial 
filter, click “new”



Develop—Radial Filter

To add or erase from 
areas of the all local 
adjustment filters 
• Click the word 

“Brush”
• You can now brush 

in additional areas
• To erase 

areas…after clicking 
brush, then click on 
Erase

• And set Size, 
feather, flow, auto 
mask as wanted



Exporting
To Export an image
• Main Menu 

Bar>Edit>Export



Exporting Fill in the following areas…Use this information to 
create an export for Riverbend Sized Images
• Export Location

• Export to: Specific Folder
• Folder: Choose where it should be stored

• I made a folder on my desktop 
labeled Riverbend Club Images

• File Naming
• If you are exporting 1 image at a time 

then you can rename here.
• Check box
• Choose naming format
• Type in custom text, etc

• If you are exporting several then you may 
prefer to rename them after they are 
exported to their folder

• I rename later 
• File Settings

• Image format:  Jpeg
• Quality:  100
• Color Space:  sRGB



Exporting • Image Sizing
• Check resize to Fit
• Select “Width & Height”
• Fill in W: 1920  H: 1080
• Resolution:  125
• Pixels per inch

• Output Sharpening
• Check “Sharpen for: Screen”
• Amount: High

• Metadata
• Include: all Metadata

• Watermarking
• Not checked

• Post-Processing
• After Export:  Do Nothing

• Create Preset if you want
• After creating preset then Export
• If not creating preset then click 

Export



Export—How to create Preset
To Create a Preset
• Click Add in the lower left 

corner of the Export window
• A “New Preset” window will 

open
• Fill in “Preset Name:”
• Select the “Folder” or create a 

new folder
• Click “Create”
• The Preset will be listed in the 

left window of the export 
window 

• To use the preset
• Select image(s) to be 

exported
• File>Export
• Click on the preset at the 

left side of the export 
window

• Click export
• All images will export to 

the destination and size 
listed in the preset



Resources and References

• https://lightroomkillertips.com/

• The Adobe Photoshop Lightroom Classic CC 
Book for Digital Photographers by Scott Kelby

https://lightroomkillertips.com/


Class 3



Resources and References

• https://lightroomkillertips.com/

• The Adobe Photoshop Lightroom Classic CC 
Book for Digital Photographers by Scott Kelby

https://lightroomkillertips.com/


Develop Module--Crop
This is the crop symbol

The Padlock
• Closed—aspect ratio won’t change
• Open—aspect ratio can be changed 

freely

To unlock padlock—click on the lock

Click on the arrows next to 
“Original” and get a drop down 
menu of preset sizes or the 
ability to create custom sizes

Angle-rotates in order to straighten such as horizons or building edges
• Auto will often do a great job
• Click on the level icon, then move cursor to image, click and drag 

the line along an edge that you want to be horizontal or vertical, 
and release.

• Or use the slider



Develop Module--Crop



Develop Module--Crop



Develop Module--Crop



Customizing



Interface--Customizing

Changing The Size of The Side 
and Bottom Panels

• Cursor is near the edge of the 
panel 

• Double arrow will appear
• Click and pull to the desired 

size



Interface--Customizing

Filmstrip—showing panel adjusted from 
small to large



Interface--Customizing
To close one panel as another is 
opened…
…Right click on the area next to any of 
the panel descriptions (example…to the 
left of the words Split toning)
…window will open
…Click Solo Mode
…Now one panel will close as the new 
one opens

You can also customize the panel layout 
by selecting that option…
…you can turn off viewing any panel you 
don’t use and don’t want to see
…you can also reorder the panels to suit 
your needs by dragging into a new 
location

Right Click here



Interface_Customizing

Right click in this 
area to bring up 
window

Click and drag to 
rearrange order of 
panels



The Interface—Customizing
Identity Plate Set-up
Mac—find in Lightroom menu
PC—Find in Edit menu

Or Add Logo by clicking 
on “Use a graphical 
identity plate”



Interface--Customizing

To change the color around 
the image

• Right click in the area 
around the image panel

• Select one of the 6 choices



Interface--Customizing Customizing Grid View

• Right click in gray area 
of grid frame

• Click on View Options
• New Window will open
• “Grid View” is 

highlighted
• Check “Show Grid 

Extras”
• Select Expanded Cells 

or Compact Cells
• Check the information 

you want to see



Interface--Customizing
Customizing the Loupe View Options

• Highlight the Loup view
• Check show info Overlay
• Choose the items you would like to 

view In Loupe info 1
• Choose the items you would like to 

view in Loupe info 2

To view Loupe Information

• While in Loupe view-Library or Develop Module
• Click the letter ”I”
• Click I again to see Info 2
• Click again to hide information



Interface--Customizing

To view Loupe Information

• While in Loupe view-Library or Develop Module
• Click the letter ”I”
• Click I again to see Info 2
• Click again to hide information



Adding Copyright to Import



Copyright Preset

Making the © symbol —
Mac…Option + g
PC with side keyboard…alt + 0169
PC Laptop with side keyboard…alt + Fn + 1069
PC without side keyboard…type (C ) without a space



Copyright Preset Fill in at least
all Lines that are
Highlighted in RED

Yours may not be 
red. Go through 
your form and 
click on the check 
mark box for each 
shown here plus 
any others you 
want.

I have started it 
but there are 
more blanks to fill 
in.

When complete 
click Create



Adding Copyright to Import

• Now go back to Metadata of the Apply During 
Import section of the Import menu

• Click on the arrows
• Find your copyright preset
• Click on it and it will show up in the box



Adding Copyright to Import



Power Point



Resources and References

• https://lightroomkillertips.com/

• The Adobe Photoshop Lightroom Classic CC 
Book for Digital Photographers by Scott Kelby

https://lightroomkillertips.com/


Keyboard Shortcuts
• D -- Develop Module
• E -- Loupe view
• F – Full screen (click F again to return)
• G -- Grid view
• I – Information (continue to click I to toggle through information screens)
• L -- Lights out
• P—In Library Module = Pick
• U -- Unpick
• X – In the Library Module = Rejected                                                                                            

--In the Develop Module--Changes crop tool from horizontal crop to vertical and vise versa
• Y– In Develop Module-Toggles through Before/After views (press D to get back to Loupe view)
• Tab -- Opens and closes panels
• Commd (Contl) +Z – Undo (Use for each step back)
• Shift – hold shift to draw a perfect horizontal or vertical (as with Graduated filter) or to draw out a 

perfect circle



Library Interface--Right Panel



Import

• As files are being imported
• Cull images with Pick Flags
• Start working with images in Develop module



Moving Folders
• If a folder has NEVER 

been imported to 
Lightroom it can be 
moved from one 
location to another as it 
is imported through the 
import menu

• If the folder is ALREADY
in the Lightroom catalog 
then it can be MOVED 
to another location 
through the Library 
module

Images will be visible if they can be imported.  If images are grayed out then they 
must be moved inside the Library Module.



Moving Files/Folders
When MOVING through the 

IMPORT menu
• Locate/select the file to be 

moved on the source (left) 
side of the import panel

• Check mark only the images 
to be moved

• In the right panel, fill in “File 
Handling”, “File Renaming”, 
“Apply During Import”, and 
choose the Destination of 

the files/folder to be moved
• Click Import



Moving Folders To move one or more images to a new 
location

• Highlight the image or images to 
be moved and drag and drop them 
into there new location.

• Cursor MUST be ON the image not 
the gray area around the image 
when you click to drag

• This window will open

• Click Move



Moving Folders
TO MOVE AN ENTIRE FOLDER

• Highlight the folder to be moved 
and drag and drop it to the new 
location.

• This window will open

• Click Move



Moving Folders or images

Images or Folders that are already in the 
Lightroom Catalog MUST be moved through 
Lightroom or Lightroom will NOT be able to 

find them!!



Moving Folders or images WHAT DOES ? AND ! MEAN

• If Image is stored on an 
external hard drive 
either the drive isn’t 
connected to the 
computer or the image 
has been moved 
outside of Lightroom

• If Image is stored on the 
computers hard drive 
but the image or folder 
was moved outside of 
Lightroom



Finding Missing Folders/Files

When ! Appears
• Right click on image
• Drop down will open
• Select “Show in Finder”

When ? Appears on a folder
• Right click on the selected folder
• Select “Find Missing Folder”
• This will take you to the file section 

where you can locate where you 
moved it.



Finding Parent Folder

When you import “Add” a folder that is subfolder, that is inside a folder 
that hasn’t been imported to Lightroom you aren’t able to see the main 
folder…
• To be able to see the Main, “Parent” folder
• Right click on the subfolder
• Click add parent folder



Selecting Images

To select 1 image click anywhere inside the cell
To select an additional image-Commd (Contl) Click on additional image
To select a series of image in a contiguous row-click the first image then shift click the last image in sequence 
To remove any image from selection-Commd (Contl) click on the image(s) to be removed



Selecting Images

Notice the different shades of gray of the cells in the grid view
• The darkest shades of gray are NOT selected
• The lightest 2 shades of gray ARE selected
• The very lightest gray cell is the primary selection
• When syncing the very lightest gray cell adjustments 

will be applied to the other light cells 



Syncing Selected Images
This is the loupe view 
of the primary 
selected image of the 
group of selected 
images

With a group of 
image selected and 
an edited image as 
the primary 
selected 
image…Click sync



Syncing Selected Images
From the pop up window…
Select the adjustments that 
you would like to sync from 
the primary image to the 
rest of the selected images.

It can be all of the 
adjustments or just a 
selected 1 or more

“Process Version” must 
always be checked

Once correct boxes are 
checked…click 
“synchronize”

The adjustments will sync 
to all of the selected 
images

Individual adjustments can 
be made to each image as 
desired.



Photo Merge--Pano

• Locate the images to be merged and select all of them
• Right click on any one of the images
• A window will pop up



Photo Merge--Pano
Right click on one of 
the selected cell 
and the pop up will 
appear

Select Photo Merge

Another window 
will appear

Select Panorama

A new window will 
open



Photo Merge--Pano
• This window will open and 

LR will begin to merge the 
images

• There are 3 projection that 
you can test

• Some may or may not work 
with your images

• Chose your favorite
• To fill in any gaps around 

the edge you may slide the 
boundary warp slider

• Once satisfied with results 
…click “merge”



Photo Merge--Pano

Lightroom will merge the images into a panorama and 
place the merged image next to the individual images

Notice the name of the 
merged image



Photo Merge--HDR

• Select the images to be merged
• Right click on one of the selected images
• A pop up will appear

Exposure -1.0 Exposure  0.0 Exposure +1.0



Photo Merge--HDR
From the Pop up 

• Select Photo Merge
• Select HDR
• A new window will open



Photo Merge--HDR
From the Window

• Select Auto Align
• Show Deghost Overlay
• Select the amount of 

Deghosting
• Were the images 

handheld or on a 
tripod

• Was it windy?
• When satisfied …Click 

Merge



Photo Merge-HDR

HDR Merge will be place next the the individual images

Title reflects HDR merge



Keyboard Shortcuts
• D -- Develop Module
• E -- Loupe view
• F – Full screen (click F again to return)
• G -- Grid view
• I – Information (continue to click I to toggle through information screens)
• L -- Lights out
• P—In Library Module = Pick
• U -- Unpick
• X – In the Library Module = Rejected                                                                                            

--In the Develop Module--Changes crop tool from horizontal crop to vertical and vise versa
• Y– In Develop Module-Toggles through Before/After views (press D to get back to Loupe view)
• Tab -- Opens and closes panels
• Commd (Contl) +Z – Undo (Use for each step back)
• Shift – hold shift to draw a perfect horizontal or vertical (as with Graduated filter) or to draw out a 

perfect circle



Class 4



Backing Up

When you close LR
• A window will open 

• Select how often you want LR to ask you about 
backing up

• Select the location for the backup
• Click…Back up

Suggestion:  Vary the locations of your 
back ups



Develop Module–Left Panel



Develop--History

If you open the HISTORY panel
• You can view every editing step 

you have done to the image.  
• You can use this panel to step 

back in editing
• Just click on the appropriate line, 

then you can continue to edit if 
you would like or be finished



Develop Module--Snapshots

Snapshots can be made anytime along the edit.  
• Click on the + and a window will open. 
• Custom name the snapshot or keep the date/time.
• Click Create. 
• View each snapshot by clicking between them and choose where you want to stop.

To remove snapshot
• Highlight item for removal
• Click on the - button



Collections
Collection Sets---

• Can contain images, 
collections or collection sets
• Think of it as a File 

Cabinet Drawer
• Can also be located inside 

another Collection Set
• Think of it as a file 

folder inside a file 
cabinet drawer

• Use as a way of organizing

Collection---
• Contains images
• Can be inside a Collection 

Set
• Think of it as the papers 

inside of a file folder
• Must be used to sync with 

Lightroom Mobile/Lightroom



Collections



Collections



Collections When a collection is 
sync’d
• The collection will 

be visible and 
editable in 
Lightroom Mobile 
Apps
• On smart 

phone
• Or Tablet



Renaming Image

To Rename Photo…Select photo>Library>Rename 
photo



Edit In

To edit in other software…
• Right click on image 

(either in Library or 
Develop Module)

• Edit In>Photoshop 2019 
(or software of your 
choice)

Another way to move a photo 
to Photoshop CC is 
Commd (Contl) + E



Photoshop to Lightroom
Complete edit in 
Photoshop

• To return edit to 
Lightroom Classic
• Commd + S
• (Save)



Photoshop to Lightroom

Back in Lightroom Classic
• Photoshop Edit will be saved 

next to the Lightroom version 
of the image as a .psd or .tif

• The Photoshop edit initially 
appears highlighted



Photoshop to Lightroom

To get Photoshop edit to stack 
next to the original in Lightroom 
Classic
• Preferences>External 

Editing>Stack with Original



Lights Out

Sometimes it can be easier to view an image with a 
dark surrounding.

To Turn the “lights out”… click the L key once to 
dim the background lights. Click L again to make 
the background black.  To turn the lights back on 
click the L one more time.



The Interface—Library Module
Bottom Tool Bar—Grid View

You can choose what shows in this 
bar by clicking on the arrow on the 
right end of the bar and checking the 
options you want to see

You can have different options in 
the grid and loupe view even 
thought they are both in the 
Library Module 

Compare View Survey View

Hover over each to see 
what they are and their 
keyboard shortcut



Library—Bottom Bar

• Have an image or images highlighted
• Click the color to rate the image(s) that are 

highlighted
• You can also use keyboard short cuts to 

apply rating
• 6=red
• 7=yellow
• 8=green
• 9=blue
• Purple doesn’t have one

Paint

• Select the spray paint can
• Option panel will open
• Select which option to 

spray onto image

Works well when images 
that need the same 
details are sprinkled 
throughout instead of 
located close to each 
other.



The Interface—Library Module
Bottom Tool Bar—Grid View—Compare View

Compare View Survey View

• Select the 2 images to compare
• Click x for the one that doesn’t make 

the cut
• The next image will come into the 

candidate side while the un-”X”ed
one will move to the select side

• And so on



The Interface—Library Module
Bottom Tool Bar—Grid View—Survey View

Compare View Survey View

While in survey mode 
• Bottom left corner-–flag pick/reject
• Bottom right corner—X out of 

survey group



The Interface—Develop Module
Bottom Tool Bar

You can choose what shows in this 
bar by clicking on the arrow on the 
right end of the bar and checking the 
options you want to see

Reference View Before/After View



Interface-Filmstrip



Interface-Filmstrip



Troubleshooting

If the minimize/maximize bar disappears….
• Shift + F …to get it back



HSL--Panel
• HSL panel can be 

viewed as individual 
Hue, Saturation, or 
Luminance Panels or all 
in one as seen here.

• Hue shifts the color 
tone

• Saturation can add or 
subtract saturation 

• Luminance lightens and 
darkens

• Use the “target 
adjustment” tool by 
clicking on the tool and 
then scrubbing up or 
down on the color to be 
adjusted



Tone Curve Panel



Library Module--Ratings
To assign a title to a color rating…
• Library Module
• Metadata 
• Color Label Set
• Edit
• Type title next to color
• Click Change
• When you hover over color 

you will see description



The Interface



Interface-Library Module
Left Side Panel

Closed View

Open Panels

Right click –
• Options 

window will 
open

• Choose 
what you 
want to use

• Solo Mode



The Interface



Importing to Lightroom
Destination Panel
• Where do you want to 

store your image
• Find the main location 

and then the 
folder/sub folder

• If you need to create 
a sub folder then

• Check – Into 
Subfolder

• Type title of the new 
subfolder

• Organize-choose…Into 
one folder or By Date


